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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez I'Aide de I'application.

Windows ou Linux |Equivalent Mac Effet

Sélection du menu

- . LibreOffice > Préférences Acces aux options de configuration
Outils > Options

Control+clicouclic droit

Clic droit . . - Ouvre un menu contextuel
selon la configuration de I'ordinateur
Ctrl (Control) (Command) Utilisé avec d’autres touches
F5 Shift+@®+F5 Ouvre le navigateur
F11 @+T Ouvre l'onglet Styles et Formatage

du volet latéral
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Introduction

Ce chapitre couvre les méthodes de partage et de révision collaboratives des classeurs : édition si-
multanée, enregistrement des modifications, ajout de commentaires, révision des modifications, fu-
sion et comparaison de documents, enregistrement et utilisation des versions d’un document.

Partager des documents (collaboration)

Partager un classeur permet a plusieurs utilisateurs d’ouvrir en méme temps le méme fichier pour
le modifier. Ce classeur doit se trouver sur un disque partagé, un serveur, un site web ou quelque
chose d’équivalent. Certaines conditions doivent étre réunies concernant la gestion des permis-
sions des utilisateurs par les systémes d’exploitation :

» le fichier partagé doit étre situé a un emplacement accessible a tous les collaborateurs ;

* les permissions du fichier du document et celles du fichier verrou correspondant doivent étre
paramétrées de telle maniére que tous les collaborateurs puissent créer, effacer et modifier
les fichiers.

Consultez la documentation de votre systeme d’exploitation pour plus de détails sur la facon de
définir les permissions des fichiers. Voyez aussi « Ouvrir et enregistrer des fichiers sur des ser-
veurs distants » dans le chapitre 1, Présentation de LibreOffice du Guide du débutant.

/Q\ Conseil
Chaque collaborateur doit au minimum saisir son nom dans la page LibreOffice — Données
d’identité de la boite de dialogue Options (Outils > Options dans la barre de menu).

Paramétrer un classeur pour le partage

A tout moment, vous pouvez paramétrer un classeur pour le partager avec d’autres utilisateurs.
Une fois le classeur ouvert, choisissez Outils > Partager le classeur pour activer les fonctionnali-
tés de collaboration pour ce document.

Partager le document

[vIPartager cette feuille de calcul avec d'autres utilisateurs

Remarque : les modifications des attributs de formatage comme les
polices, les couleurs et les formats de nombre ne seront pas enregistrées
et certaines fonctions comme |'édition des diagrammes et les objets de
dessin ne sont pas disponibles en mode partagé. Désactivez le mode
partagé pour avoir un accés exclusif nécessaire pour ces modifications et
fonctions.

Utilisateurs accédant actuellement a cette feuille de calcul

Nom ‘Accédé

Jean-Luc Vandemeulebroucke (accés exclusif)  13/02/2020 14:34 14:34

Aide Annuler

Figure 1 : Choisir de partager un classeur.
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Pour activer le partage, cochez la case en haut de la boite de dialogue, puis cliquez sur OK. Si le
classeur a été enregistré auparavant, un message apparait vous indiquant que vous devez enre-
gistrer le document afin d’activer le mode partagé. Cliquez sur Oui pour continuer. Sinon, la boite
de dialogue d’enregistrement s’ouvre. Aprés enregistrement, la mention (partagé) est alors affichée
dans la barre de titre, a la suite du nom du fichier.

La commande Outils > Partager le classeur peut étre utilisée pour basculer un document du
mode partagé au mode non partagé. Cela signifie que les autres utilisateurs ne pourront plus le
modifier. Vous pouvez préférer enregistrer une copie du classeur partagé sous un autre nom ou a
un autre emplacement, puis de basculer cette copie en mode non partagé.

Ouvrir un classeur partagé

Lorsque vous ouvrez un classeur qui est en mode partagé, un message apparait vous indiquant
gue le document est en mode partagé et que certaines fonctionnalités ne sont pas disponibles
dans ce mode. Cliquez sur OK, et le document est ouvert en mode partagé.

Les fonctions suivantes ne sont pas disponibles dans un classeur partagé :
Edition > Suivi des modifications, sauf Fusionner le document

Insertion > Vidéo ou son

Insertion > Commentaire

Insertion > Objet

Insertion > Diagramme

Insertion > Plage ou expression nommée
Insertion > Table dynamique

Insertion > Cadre flottant

Insertion > Fontwork

Insertion > Ligne de signature

Format > Fusionner les cellules
Format > Zones d’'impression

Feuille > Déplacer/copier la feuille

Feuille > Supprimer des feuilles

Feuille > Insérer une feuille a partir d’un fichier
Feuille > Plage ou expression nommée

Feuille > Renommer la feuille

Feuille > Couleur de I'onglet

Données > Définir la plage
Données > Trier

Données > Sous-totaux
Données > Validité

Données > Opérations multiples
Données > Consolider

Données > Plan et groupe
Données > Table dynamique

Enregistrer un classeur partagé

Quand vous enregistrez un classeur partagé, une des situations suivantes peut se produire :
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*  Sile document n’a pas été modifié et enregistré par un autre utilisateur depuis que vous
I'avez ouvert, le document sera enregistré.

* Sile document a été modifié et enregistré par un autre utilisateur depuis que vous l'avez ou-
vert, I'un des événements suivants va se produire :

— Si les changements ne sont pas en conflit, le document est enregistré. Un message appa-
rait, vous indiguant que votre classeur a été mis a jour et enregistré par d’autres utilisa-
teurs, et toutes les cellules modifiées par I'autre utilisateur apparaissent avec une bordure
rouge.

— Si les changements sont en conflit, la boite de dialogue Résoudre les conflits s’ouvre.
Vous devez décider pour chaque conflit quelle version conserver, la vbtre ou celle de
l'autre personne. Lorsque tous les conflits sont résolus, le document est enregistré. Pen-
dant que vous résolvez les conflits, aucun autre utilisateur ne peut enregistrer le docu-
ment partagé.

*  Siun autre utilisateur essaie d'enregistrer le document partagé et de résoudre les conflits, un
message apparait vous indiqguant que le fichier classeur partagé est verrouillé a cause d’'une
fusion en cours. Vous pouvez alors renoncer a la commande Enregistrer pour le moment, et
réessayer plus tard.

Une fois que vous avez enregistré avec succeés un document partagé, le document affiche la toute
derniére version de tous les changements enregistrés par tous les utilisateurs.

Réviser des documents

Vous pouvez utiliser plusieurs méthodes pour réviser, modifier et commenter un classeur.

*  Vous pouvez utiliser les marques de modifications pour montrer les ajouts, les suppressions
et les changements de formats. Plus tard, vous (ou un autre utilisateur) pourrez réviser le do-
cument et accepter ou rejeter chaque modification.

*  Sivous n'utilisez pas le partage de fichier, vous pouvez effectuer les modifications dans une
copie du document (enregistré dans un dossier différent, avec un nom différent, ou les deux),
puis utiliser Calc pour comparer les fichiers et mettre en évidence les changements. Voir
« Comparer des documents » page 11.

*  Vous pouvez enregistrer des versions qui seront conservées dans le fichier original. Voir
« Enregistrer des versions » page 12.

Les relecteurs peuvent laisser des commentaires dans le document, attachés a des modifications
particulieres ou autonomes.

...#
o~

= Remarque

Ces outils sont identiques a ceux utilisés dans Writer pour le suivi des modifications.

Préparer un document pour la révision (facultatif)

Quand vous envoyez un document a un autre utilisateur pour révision ou édition, vous pouvez tout
d’abord vouloir le protéger afin que I'éditeur ou le relecteur n’ait pas a se souvenir de bien activer
les marques de modifications.
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Une fois les marques de révision activées, vous pouvez protéger le document par un mot de passe
gue tout utilisateur devra saisir pour désactiver la protection et accepter/rejeter les modifications.

1) Ouvrez le classeur et sélectionnez Edition > Suivi des modifications > Enregistrement
dans la barre de menu. Une coche apparait devant cette option pour indiquer que I'enregis-
trement est actif. Vous pouvez aussi utiliser Fichier > Propriétés et cocher Enregistrer les
modifications dans l'onglet Sécurité.

2)  (Faculatif) Cliquez sur Edition > Suivi des modifications > Protéger. Dans la boite de dia-
logue Protéger I'historique, saisissez un mot de passe, confirmez-le et cliquez sur OK. Vous
pouvez aussi cliquer sur le bouton Protéger dans I'onglet Sécurité de la boite de dialogue
Propriétés pour ouvrir la boite de dialogue Saisir le mot de passe.

Enregistrer les modifications

Pour enregistrer les modifications, ouvrez le classeur et vérifiez qu'il y a une coche, ou un fond
bleu autour de l'icdne selon votre systeme d’exploitation, devant I'élément Edition > Suivi des
modifications > Enregistrement pour indiquer que cette fonction est active.

Désactiver I'enregistrement des modifications aprés avoir effectué des changements met fin
a cet enregistrement. Toute information concernant les modifications est alors perdue. Une
boite de message vous en prévient si vous essayez de le faire.

La suite de ce chapitre va étre illustrée par 'exemple de I'élaboration d’'un budget pour une équipe
de football.

Mettez-vous dans la situation d’un président d’un club de football. L'entraineur d’une équipe de
jeunes vous a soumis un budget pour la saison, et vous avez besoin de le modifier et de lui retour-
ner la nouvelle version.

Vous vous inquiétez du fait que, si vous faites simplement des modifications, I'entraineur ne verra
donc pas les changements que vous avez effectués. Vous décidez alors d'utiliser et d’activer la
fonctionnalité d’enregistrement des modifications, pour que I'entraineur puisse voir facilement les
changements que vous avez effectués.

La Figure 2 montre le classeur du budget que I'entraineur vous a soumis.

A | B | ¢ | b | :
1 Budget Equipe Cadets Football
2 |Description Quantité Prix unitaire Total Commentaires
3 |Maillots, shorts et chaussettes 15 40,00 € 600,00 €Besoin d'un nouveau look pour 'équipe
4 |Ballons d'entrainement 20 20,00 € 400,00 €1 par joueur + 5 en réserve
5 |Ballons match 3 40,00 € 120,00 €Pour la saison
6 |Coiits d'arbitrage 18 50,00 € 900,00 €1 arbitre par match
7 |Collations 18 40,00 € 720,00 €1 collation aprés chaque match
8 |Gants gardien 1 15,00 € 15,00 € Pour le gardien
9 |Protége-tibias de rechange 5 15,00 € 75,00 €£En cas d'oublis
10 |Chasubles d'entralnement 20 4.00€ 80,00 €1 par joueur + 5 en réserve
11 Total 2910,00 €
12

Figure 2 : Classeur du budget de I'équipe de football.
En examinant les chiffres, vous voyez que vous pourriez économiser sur certains postes :

* les collations d’'aprés-match peuvent étre apportées par les parents ;
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* les nouveaux maillots peuvent attendre : en acheter seulement 5 pour remplacer ceux qui
sont USés ;

e acheter des ballons d’entrainement moins chers ;
* acheter seulement 2 protége-tibias de rechange ;

Pour effectuer ces modifications, utilisez I'enregistrement des modifications de Calc. Pour com-
mencer cet enregistrement :

1) Ouvrez le classeur contenant le budget.
2) Sélectionnez Edition > Suivi des modifications > Enregistrement dans la barre de menu.
3) Commencez a modifier le document.

Une bordure colorée, avec un point dans son coin supérieur gauche (comportement par défaut),
apparait autour de la cellule ou une modification a été effectuée (Figure 3). Les autres utilisateurs
peuvent alors facilement savoir quelles cellules ont été modifiées. Une ligne ou une colonne sup-
primée est marquée par une barre colorée épaisse.

A e c | Db | E |
1 Budget Equipe Cadets Football
2 |Description Quantité Prix unitaire Total Commentaires
3 |Maillots, shorts et chaussettes 5 40,00 € 200,00 €Besoin d'un nouveau look pour I'équipe
4 |Ballons d'entrainement 20 15,00 € 300,00 €1 par joueur + 5 en réserve
5 |Ballons match 3 40,00 € 120,00 €Pour la saison
6 |Coits d'arbitrage 18 50,00 € 900,00 €1 arbitre par match
7 |Collations [ 0 40,00 € 0,00 €1 collation aprés chaque match
8 |Gants gardien 1 15,00 € 15,00 €Pour le gardien
9 |Protége-tibias de rechange 2 15,00 € 30,00 €£En cas d'ouhlis
I TWlchasubles d'entrainement 20 4,00 € 80,00 €1 par joueur + 5 en réserve
11 Total 1645,00 €
12

Figure 3 : Classeur édité ou les cellules modifiées sont bordées de rouge.

Pour voir ce qui a été modifié dans une cellule, survolez-la avec le pointeur de la souris comme sur
la Figure 4.

A Eas ¢ | o | E

1 Budget E_( Jean-Luc Vandemeulebroucke, 16/03/2020 17:01:33:

> Description Quantité ﬂ:ri:-' Cellule B3 maodifiée de '15' en '5°

3 |Maillots, shorts et chaussettes 5 40,00 € 200,00 €Besoin d’un nouveau loak pour I'équipe
4 |Ballons d'entrainement 20 15,00 € 300,00 €1 par joueur + 5 en réserve

5 |Ballons match 3 40,00 € 120,00 €Pour la saison

Figure 4 : Voir les détails d’'une modification.

Eg Remarque

Certaines modifications, comme le formatage d’'une cellule par exemple, ne sont ni enregis-
trées ni signalées.
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:Q/_ Astuce

Pour modifier la couleur qui signale les modifications, sélectionnez Outils > Options >
LibreOffice Calc > Modifications. Par défaut, une couleur différente sera attribuée a
chaque relecteur (s'il a pris soin de renseigner son nom comme indiqué dans « Partager
des documents (collaboration) » page 1).

Une fois que vous avez terminé vos modifications dans le document, vous pouvez I'envoyer a
votre entraineur.

Vous aurez peut-étre envie d'expliguer le raisonnement qui a guidé les modifications que vous
avez effectuées. Vous pouvez exprimer votre point de vue de deux maniéres : en ajoutant des
commentaires aux changements que vous avez effectués, ou en ajoutant des commentaires glo-
baux au classeur.

Ajouter des commentaires aux modifications

Calc ajoute automatiquement a toute modification enregistrée un commentaire qui précise ce qui a
été modifié (par exemple, Cellule B3 modifiée de '15' en '5'). Les relecteurs et les auteurs peuvent
ajouter leurs propres commentaires pour expliquer les raisons de leurs modifications.

Pour ajouter un commentaire a une modification :
1) Faites la modification dans le classeur.
2) Selectionnez la cellule ou la modification a été effectuée.

3) Choisissez Edition > Suivi des modifications > Commentaires. La boite de dialogue de la
Figure 4 s’ouvre. Le commentaire ajouté automatiquement par Calc ne peut pas étre modifié.

4) Saisissez votre propre commentaire et cliquez sur OK.

= Remarque

N'utilisez pas I'entrée Insertion > Commentaire de la barre de menu ou Insérer un com-
mentaire du menu contextuel dans ce cas. Les commentaires insérés par ces méthodes
sont géres de facon différente et n'apparaissent pas dans la boite de dialogue Gérer les mo-
difications.

Cellule B3 modifiée de 15" en '5'

Contenu
Auteur Jean-Luc Vandemeulebroucke, 16/03/2020 17:01
Texte

On ne remplace que les équipements usés.

Aide g Annuler

Figure 5 : Saisie d’un commentaire associé a une modification.
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Une fois que vous avez ajouté un commentaire a une cellule modifiée, vous pouvez I'afficher (sous
forme d’infobulle) en placant le pointeur de la souris au-dessus de la cellule, comme Figure 6 :

A Emas c | 0 | E |

1 Budget E ¢ Jean-Luc Vandemeulebroucke, 16/03/2020 17:01:33: l
r l'équipe

> |Description Quantité iy On ne remplace que les équipements uses.
:.Maillots, shorts et chaussertes| E SW.( Cellule B3 modifiée de '15 en '5)

4 |Ballons d’entrainement 20 15,00 € 300,00 €1 par joueur + 5 en réserve
5 |Ballons match 3 40,00 £ 120,00 €Pour la saison

Figure 6 : Commentaire ajouté a la cellule B3.

Le commentaire s’affiche également dans la boite de dialogue ou vous acceptez ou refusez les
modifications, comme illustré sur la premiére ligne de la Figure 10 page 10.

Editer les commentaires des modifications

1) Sélectionnez la cellule dont vous voulez modifier le commentaire.

2) Choisissez Edition > Suivi des modifications > Commentaires dans la barre de menu. La
boite de dialogue de la Figure 5 s’ouvre.

3) Modifiez le commentaire et cliquez sur OK.
Le commentaire ajouté automatiquement par Calc ne peut pas étre modifié.

Vous pouvez parcourir les commentaires grace aux fleches situées en bas de la boite de dialogue.

Ajouter d’autres commentaires (commentaires généraux)

Calc dispose également d’'un autre type de commentaires (appelés « notes » dans les anciennes
versions de LibreOffice), que les auteurs et les relecteurs utilisent souvent pour échanger des
idées, formuler des suggestions et réfléchir collectivement dans un document.

Pour ajouter un commentaire général :
1) Sélectionnez la cellule a laquelle le commentaire va s'appliquer.

2) Sélectionnez Insertion > Commentaire dans la barre de menu ou faites un clic droit et choi-
sissez Insérer un commentaire. Une zone de saisie apparait, comme Figure 7.

1 par joueur + 5 en réserve

Pour la saison

1 arbitre par match

1 collation aprés chaque match |
Pour le gardien —
En cas d'oublis ¥

[1 par joueur + 5 en réserve ]__

Figure 7 : Insertion d’un commentaire général.
3) Saisissez le texte de votre commentaire dans cette zone.
4)  Cliquez en dehors de la zone pour la fermer.

La cellule a laquelle vous avez ajouté un commentaire comporte désormais un point coloré dans le
coin supérieur droit, comme illustré Figure 8. Elle n'a pas de bordure colorée, a moins que la cel-
lule ait été également modifiée.
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En cas d'oublis E
1 par joueur + 5 en réserve

Figure 8 : Point coloré dans une cellule qui comporte un commentaire.
:g Remarque

Si le point coloré n'apparait pas pour signaler une cellule dans laquelle se trouve un com-
mentaire, vérifiez, dans Outils > Options > LibreOffice Calc > Affichage, si I'option /ndica-
teur de commentaire est bien cochée.

_:Q:_ Astuce

Vous pouvez modifier la couleur d’arriere-plan par défaut des commentaires dans Outils >
Options > LibreOffice > Couleurs de l'interface.

Pour afficher le commentaire que vous venez d’ajouter, placez le pointeur de la souris au-dessus
de la cellule correspondante ; le commentaire apparait, comme ci-dessous.

1 par joueur + 5 en réserve
Pour la saison
1 arbitre par match

1 collation aprés chaque match Pourquoi 5 en
Pour le gardien |[ESENE ?

En cas d'oublis y

[1 par joueur + 5 en réserve N 1

Figure 9 : Affichage d’un commentaire.

Modifier des commentaires

Vous pouvez modifier et formater le texte d’'un commentaire, comme vous le feriez pour tout autre
texte.

1) Faites un clic droit dans la cellule contenant I'indicateur de commentaire et choisissez Affi-
cher le commentaire dans le menu contextuel.

2) Sélectionnez le commentaire, puis faites un double-clic a I'intérieur de celui-ci. Le curseur
change d'aspect pour prendre sa forme habituelle qui marque I'entrée de texte en clignotant,
et la barre d’outils Formatage qui était indisponible devient active et affiche les attributs du
texte.

3) Une fois la modification effectuée, cliquez a I'extérieur du commentaire pour le désélection-
ner. Pour masquer a nouveau le commentaire, faites un clic droit dans la cellule et cliquez
sur Masquer le commentaire dans le menu contextuel.

Formater les commentaires

Vous pouvez changer la couleur d’arriére-plan, le style de bordure, la transparence et d’autres at-
tributs d’'un commentaire.

1) Faites un clic droit dans la cellule contenant I'indicateur de commentaire et choisissez Affi-
cher le commentaire dans le menu contextuel.

2) Cliguez dans le commentaire lui-méme. La barre d’outils Formatage change pour afficher la
plupart des options de formatage des commentaires. Ce sont les mémes que les options
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pour formater les éléments graphiques ; voir le chapitre 5, Utiliser des éléments graphiques
dans Calc, pour plus d’'informations.

Vous pouvez également faire un clic droit sur le commentaire pour afficher un menu d'op-
tions, certaines menant a des boites de dialogue vous permettant de paramétrer finement le
formatage ; ces boites de dialogue sont également décrites dans le Chapitre 5.

3) Une fois la modification effectuée, cliquez a I'extérieur du commentaire pour le désélection-
ner. Pour masquer a nouveau le commentaire, faites un clic droit dans la cellule et cliquez
sur Masquer le commentaire dans le menu contextuel.

Rechercher les commentaires en utilisant le Navigateur

Les petits indicateurs de commentaire dans le coin des cellules peuvent étre difficiles a distinguer.
Par conséquent, Calc propose une autre fagon de les repérer, en affichant tous les commentaires
et en utilisant le navigateur. Pour afficher tous les commentaires généraux, sélectionnez Affichage
> Commentaires dans la barre de menu. Pour les masquer, sélectionnez de nouveau cette entrée
de menu.

S’il existe des commentaires dans un classeur, le navigateur affiche une marque (habituellement le
signe + ou une fleche) devant le mot Commentaires. Cliquez sur cette marque pour afficher la liste
des commentaires. Faites un double-clic sur le commentaire voulu pour aller directement dans la
cellule associée.
I=/ Remarque
La fonction Affichage > Commentaires et le navigateur montrent les commentaires géné-
raux mais pas ceux associés au suivi des modifications.

Accepter ou rejeter les modifications

Lorsqu’un document vous est retourné avec des modifications, tout I'intérét de I'enregistrement
des modifications devient évident. Vous pouvez alors, en tant qu’auteur initial du document, par-
courir les modifications effectuées et décider de leur sort. Pour commencer ce processus :

1) Ouvrez le document modifié.

2) Sélectionnez Edition > Suivi des modifications > Gérer. La boite de dialogue de la Figure
10 s’ouvre.

3) Vous pouvez examiner individuellement chaque modification puis I'accepter ou la rejeter au
fur et & mesure. Vous pouvez aussi accepter ou rejeter la totalité des modifications.

La colonne Commentaire contient I'explication par défaut de la modification effectuée. Si le relec-
teur a ajouté un commentaire a sa modification, il est affiché avant I'explication par défaut, comme
sur la premiére ligne de la Figure 10.

Si plus d’un utilisateur a révisé le document, un relecteur a pu rectifier une modification d’'un autre
relecteur. Dans ce cas, les modifications sont structurées logiquement avec un signe + qui permet
d’ouvrir 'arborescence. Les modifications déja acceptées ou refusées sont également regroupees.
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Gérer les modifications

Liste Filtrer
Commentaire
Feuille1B3 Jean-Luc Vi 16/03/2020 17:01: On ne remplace que les équip
=IContenu modifié Feuille1.C4 Jean-Luc V. 17/03/2020 00:29:
20 Feuille1.C4 Jean-Luc V. 16/03/2020 17:01: Choisir des ballons moins chei
15 Feuille1.C4 Jean-Luc V. 16/03/2020 17:01: Choisir des ballons moins chei
18 Feuille1.C4 Jean-Luc V. 17/03/2020 00:29: (Modifié dans '18")
=lAcceptées
Contenu modifié¢  Feuille1.B9 Jean-Luc Vi 16/03/2020 17:02: Tablons sur un oubli max (Cell
Contenu modifié¢  Feuille1.B7 Jean-Luc Vi 17/03/2020 00:38: (Cellule B7 modifiée de '0' en
=IRejetées
Contenu modifié¢  Feuille1.B7 Jean-Luc V. 16/03/2020 17:01: Collations fournies par les fam
< >
Accepter Rejeter Tout accepter || Tout rejeter

Figure 10 : La boite de dialogue Gérer les modifications.

L'onglet Filtrer (Figure 11) vous permet de filtrer les modifications. Aprés avoir spécifié les critéres
de filtre, revenez a I'onglet Liste pour voir le résultat.

Gérer les modifications

Liste Filtrer
[ Date :
depuis le V‘
31/12/2019 < 00:00 1O
et z =
[ ]Auteur :

Jean-Luc Vandemeulebroucke ‘

[IPlage :

[ Commentaire :

Tout accepter | Tout rejeter

Figure 11 : Les filtres définis ici limitent les modifications affichées dans I'onglet Liste.

Accepter Rejeter

Vous pouvez filtrer selon :

* la date : seules les modifications effectuées au cours d’'une certaine période seront affi-
chées;

* lauteur : seules les modifications effectuées par un auteur particulier seront affichées. Ceci
est particulierement utile si vous avez plusieurs relecteurs pour votre document ;

* laplage : seules les modifications effectuées dans une plage de cellules particuliére seront
affichées. Ceci est particulierement utile si votre classeur est volumineux et si vous voulez ne
réviser qu’une partie du document ;
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* le commentaire : seules les modifications dont le contenu du commentaire correspond au cri-
tére de recherche spécifié seront affichées.

Fusionner les documents

Envisageons le cas de figure ou vous avez envoyé votre proposition de budget non seulement au
président de votre club, mais aussi a votre entraineur adjoint. Tous les deux vous renvoient leur
budget révisé en méme temps. Vous pourriez réviser chaque document séparément, mais, pour
gagner du temps et étre plus efficace, vous pouvez vouloir analyser 'ensemble de leurs modifica-
tions simultanément. Pour ceci, vous pouvez utiliser la fonction de fusion de document de Calc.

Les méthodes décrites jusqu’ici sont efficaces si vous n’avez qu’un relecteur a la fois. Parfois, ce-
pendant, plusieurs relecteurs renvoient toutes les versions modifiées d’'un document en méme
temps. Dans ce cas, il est plus rapide et efficace de réviser toutes ces modifications en une seule
fois, plutét que de le faire individuellement pour chaque version. Pour ceci, vous pouvez fusionner
les documents dans Calc.

Pour fusionner des documents, la fonction d’enregistrement des modifications doit étre active pour
chacun d’entre eux.

1) Ouvrez le document d’origine.
2) Sélectionnez Edition > Suivi des modifications > Fusionner le document.

3) Une boite de dialogue de sélection de fichiers s’ouvre. Sélectionnez le fichier que vous vou-
lez fusionner et cliquez sur OK.

4)  Une fois la fusion des documents effectuée, la boite de dialogue Gérer les modifications
s’ouvre, comme dans la Figure 10, et affiche les modifications de plusieurs relecteurs. Si
vous voulez fusionner plus de documents, fermez la boite de dialogue et répétez les
étapes 2 et 3.

Les modifications sont alors combinées dans un seul document et vous pouvez les accepter ou les
rejeter au cours d’'un méme processus. Les modifications de chaque relecteur apparaissent avec
des couleurs différentes dans le document.

Comparer des documents

Parfois, quand vous partagez des documents, les relecteurs peuvent oublier d’enregistrer leurs
modifications. Ce probléme peut étre résolu par Calc, qui peut retrouver ces modifications en com-
parant des documents.

Pour comparer des documents, vous devez disposer du document original et de celui qui a été
modifié. Pour les comparer :

1) Ouvrez le document modifié que vous voulez comparer au document original.
2) Sélectionner Edition > Suivi des modifications > Comparer le document.

3) Une boite de dialogue de sélection de fichier s’ouvre. Sélectionnez le document original et
cliquez sur Ouvrir.
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A Attention

Veillez & bien ouvrir le document modifié en premier et non le document original.

Calc détecte et repére les modifications de la fagon suivante :

*  Toutes les données qui se trouvent dans le document modifié mais pas dans le document
original sont repérées comme insérées.

*  Toutes les données qui se trouvent dans le document original mais pas dans le document
modifié sont repérées comme supprimeées.

*  Toutes les données modifiées sont repérées comme modifiées.

A partir de ce point, vous pouvez parcourir ces repéres et accepter ou rejeter les modifications.

Enregistrer des versions

La plupart des documents passent par plusieurs versions. Il est souvent utile d’enregistrer les nou-
velles versions d’'un document. Vous pouvez le faire en enregistrant une copie du document (sous

un nom différent) aprés chaque révision, ou en utilisant la fonctionnalité de gestion des versions de
Calc.

A Attention

Si vous utilisez la commande Enregistrer sous a partir d’'un document qui comporte plu-
sieurs versions, ces anciennes versions ne seront pas enregistrées dans le nouveau fichier.

Pour utiliser la gestion des versions de Calc :

1) Choisissez Fichier > Versions dans la barre de menu. La boite de dialogue de gestion des
versions s’ouvre.

budget football

Nouvelles versions

Enregistrer une nouvelle version | [ 1Toujours enregistrer une nouvelle version a la fermeture

Versions existantes

Date et heure Enregistrée par Commentaires

17/03/2020 e T e e B e e R

Aide Supprimer | Comparer || Afficher... Quvrir

Figure 12 : La boite de dialogue de gestion des versions.

2) Cliguez sur le bouton Enregistrer une nouvelle version pour enregistrer une nouvelle ver-
sion.
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3)

4)

Nouvelles versions

Versions existantes

Une boite de dialogue s’ouvre, ou vous pouvez saisir un commentaire sur cette version (Fi-
gure 13).

Insérer un commentaire de version

Enregistré par : Jean-Luc Vandemeulebroucke

Version acceptée par le président

Aide Annuler

Figure 13 : La boite de dialogue Insérer un commentaire de version.

Aprés avoir saisi votre commentaire et cliqué sur OK, la nouvelle version est ajoutée dans la
liste (Figure 14).

budget football

Enregistrer une nouvelle version: | []Toujours enregistrer une nouvelle version 3 la fermeture

Date et heure |Enregistrée par |Commentaires

17/03/2020 14:55 Jean-Luc Vandemeulebroucke Original

17/03/2020 15:24 Jean-Luc Vandemeulebroucke Version acceptée par le président

Aide Supprimer | Comparer || Afficher... Fermer Quvrir

Figure 14 : Liste des versions mises a jour.

Eg Remarque

Le nouveau fichier a une taille supérieure, comme si deux classeurs étaient enregistrés en-
semble.

Une fois le fichier enregistré, les deux versions y sont présentes. Vous pouvez alors :

ouvrir une ancienne version : sélectionnez la version et cliquez sur le bouton Ouvrir ; une
copie en lecture seule de I'ancienne version s’ouvre ;

comparer toutes les versions : cliquez sur le bouton Comparer et une action similaire a la fu-
sion de documents s’effectue. Une boite de dialogue Gérer les modifications s'ouvre et liste
toutes les modifications a travers les différentes versions ;

modifier le commentaire : sélectionnez une version et cliquez sur le bouton Afficher pour af-
ficher le commentaire saisi par vous ou d’autres relecteurs ;

supprimer une version : sélectionnez la version et cliquez sur le bouton Supprimer.
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